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Follow these steps navigate to the Email Creation/

Email Send section of Marketing Cloud.

1. Click the Email Icon in the top left of the

screen.

2. Then ‘Email’ to navigate to the Email App
3. Once in the Email App, Select ‘Email’ from

the Content Tab.
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_ 2 ! Mouse over the tips 0 to find out more about these features

Emall Sacial HubExchange

ﬁ Email Overview Content v Subscribers v Interactions v Tracking v

Emalis

Shared Emalls

Overview

Simple Automated Emalls.

Recent ltems emplass Last Modife

The Emails, Templates and Images in Marketing Cloud are organized in Folders under the
Content Tab. There are two section of folders the ‘My’ folders and the ‘Shared’.

The ‘My’ folders are NOT your private folders. They are shared with all uses in your Business

Unit.

The ‘Shared’ folders are shared across business units for all of CU. Based on the folder
permissions, you may have access to view and use content in the Shared folders, but not to edit

the content.

Creating a New Folder

Within your Business Unit you should agree on a folder structure so that content is organized
and easily accessible when needed. For training/testing each user will create a folder for their

emails.

ﬁ Email
Content

(=SR] My Emails
[ATestB
[ TestE

Overview

|1 Simple Ay
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1. Right click the ‘My Emails’ folder.
2. Then click ‘New Folder’.
3. Rename the Folder

ﬂ‘ Email

Content

= [ My Emails

| Test Email 1
|4 Test Email 2

[ [Test - ASE]| 3

| Simple Automated Emails

Overview Content v

“ Wy Te
x C
|
[

OO o

In the future the folder can be Renamed, Moved or Deleted, by right clicking on the folder name.
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Create New Email From Shared Template

1. Under ‘My Emails’ click on the ﬁ Email Overview Content « Subscribers w
sub-folder you would like to
create the email in. Content “« My Emails > Training - ASE
= a3 My Emails a -84 Create = " 2:"[
2. Click ‘Create’ then ‘Template Wl Himi Bgan fecligg _ Template Based
) . Training - ASE T
Based’ to create a new email. Bl aning_ASE Y| 3
|13 Simple Automated Emails 3L Text Only
The unsubscribe footer does (3 My Templates ]

® NOT work with the ‘HTML Paste’
option. Do not select this option unless you are creating a transactional email. An
HTML paste template has been created for when you want to use HTML paste.

3' CIICk the ‘SeIeCt’ bUtton tO My Emails = Training - AE > Create Template Based Email
choose the template that will | s, @ conce
be used for the email.
3 Template
Template (required)
Select... 3
4. Select one of the ‘Shared Select Template
Templates to use. Select a Template:
[= [ Shared Templates 4 ~
= [ CU Templates
+ LayoutA
+ LayoutB
+ LayoutC
.
5. Once the correct template s{iayoutE
+ LayoutF
has been selected click Rk
+ LayoutH v
‘NeXt’ tO Contlnue Preview :
5 OK Cancel

University of Colorado | eComm
2



6. Enter a Name/Title for the
email. Note that name will
not be viewable by the
receiver of the email.

7. Enter a Subject Line for the
email and if needed a
Preheader.

A preheader is the short
=» summary text that follows
the subject line when in
some email clients and on mobile. If
the text is over the email clients
limit no text will be displayed. For
preheader best practices see the
following MC blog post:

My Emails >

) Sav 8 Cancel

=2 Template

Template (required)
Layout D

= Properties

Email Name (required)

My First Email

Email Subject (required)
Marketing Cloud Training

Preheader

Location
My Emails/Training - AE

Target Language

Training - AE > Create Template Based Email

Select...

Select...

[ United States - US-ASCII

~]

http://www.exacttarget.com/blog/10-tips-for-successful-email-preheader-text/

8. Once Name and Subject have been entered click the ‘Save’ button at the top of the

screen to continue.

Add Email Header

9. Click into the header section to add the

header.

10. Click Create Content and then Content.

Select Orientation:
Choose a thumbnail that defines the initial layout of your content area

Text Only image Only image Top

Image Bottom Image Left Image Right

Free Form HTML Only

12

This orientation does not support tables or multipie images. | < Back Next >

Cancel

Type: Empty Content

Locked: No

Lock Content

Retrieve Content

Create Content =

Content

Dynamic Content
A/B Test Content

11. Select Image Only

12. Click Next
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13. Select ‘Folder’ as the source of the

Select Image:
Choose an image for your content area

image.
13
Source: @ Folder () Other URL
14. Select ‘Shared Portfolio’ folder and then | ™" “’"";’ s 14T

se Image: (re¢—

‘CU Brander headers’ folder and then s 2
=] 3 CU branded headers
your campus folder from. BeBc U e s E—
i CU Anschutz
. . : CU Boulder 1 5
Portfolio folders hold email assets such 3 CU Dever
i boulde: 1 CU System Ider_alumni-affinity_white
as Images. ~3uccs
1 eComm_TRAINING_Feb16
— # [ Misc CU branded assets e — N
agelof 11 | H|| 4
Image Size : () small O medium (O large (@ Original
15. Select the Image you would like to use. urt

uni: | (<5

] conversion Tracking Link
There are black and white version of

16

each header. If you do not see a — —
header email contact@cu.edu to
request one.

16. Click ‘Next’ to continue.

Content Area Properties
Define the initial properties of your content area

17. Set Content Properties, background

and border color and padding. sorder size: [Opels tone
Border Color: - R

Background Color: I 17
A

» Padding on headers should always be S
Updated to 20 pixels_ Default Font: |Arial 7

Preview
If you select a black header be sure to

®» | setthe background color to black.

18. Click ‘Next’ to continue.

Edit v Format w Insert v Personalization v Orientation v & Edit | {htmi)

: 3. om 18

Arial v[1o | [B|7]|U

= Al < Back Next » Cancel

@j\ Alumni Affinity Groups
19. Preview the Image, then click ‘Save’ to finish

adding the image to the header.

19

Quick Preview Orientation: Image Only | Save Cancel
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Add Email Footer

20. Click on the bar at the bottom of the screen.

20

21. From the folder list select ‘Shared Content’ and then * FOOTERS’.

22. Click the right and left arrows to scroll through the footers in the folder.
23. Select the footer you would like to use.

24. Drag the footer into the footer content area.

® [ My Contents Erwanmmasy B P —— Be Boulder, e i -
= [ Shared Contents = e e e s - == @T
® (23 DO NOT USE-FOR DE - BeBoulder. g 22
o EEEE S 23 ~ = @T
# 3 My Surveys
AllCU_Email List  FOOTER no logo FOOTER w Be FOOTER w Be FOOTER w CU FOOTER w CU
Emails_Footer Boulder Boulder logo_left logo_center Togo_left
logo_center

25. Click the bar hide the content bar.

Office/Department/School/College | University of Colorado Campus Name
303-555-1234 | conact@campus.edu | www.campusURL edu
1234 Street Address, City, CO 80000

. 25
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26. Click into the footer section

tO update the fOOter Wlth the Type: Standard Content

correct information, and Locked: No

then ‘M0d|fy Content’ Clear Content
Lock Content

- University of Colorado Campus Name
Madify Content 26 edu | www.campusURL.edu
| ss, City, CO 80000

Store Content in Library

27 Update the Address and i“ l :nnz! - Inserl; fPischization - irifialinn b d | & Edit ] e
CIREY ) CEEE) o)l )

other information

-« <I[B7]U EEEE

. f y | University of Colorade Campus Name
28 CI|Ck Save button tO 27 303-555-1234 | conact@campus.edu | www.campusURL edu

. 1234 Street Address, City, CO 80000
continue.

28
Orientation: Text

Quick Preview Clear Content Save Cancel
Only
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Add Personalization Text

29. Click into one of the content areas,
click ‘Create Content’ and then
Content.

30. Click ‘Text Only’

31. Click ‘Next’ to continue.

32. Update ‘Content Area Properties’.

33. Click ‘Next’ to continue.

UNIVERSITY OF COLORADO BOULDER

% Alumni Affinity Groups

Locked: No

Content

Dynamic Content

A/B Test Content

Type: Empty Content

Lock Content

Retrieve Content.

Create Content »

Select Orientation:

Choose a thumbnail that defines the initial layout of your content area

Text Only

Image Bottom

Free Form

Image Top

Image Right

31

Transferring data from members.s7.exacttarget.c

Content Area Properties

Define the initial properties of your content area

Next > Cancel

Preview

Border color: [cooooo | [N ~|
Background Color: ' i

Default Font: |Arial

This is sample text. This is sample
text. This is sample text. This is
sample text. This is sample text
This is sample text.

32

33
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34. You can add text and first name

personalization.

Personalization can be added two ways.

a. By typing %% before and after the

field name, for example:
%%First Name%%.

b. Or by selecting the field from the
Personalization list.

@& hitps://members.s7.exacttarget.com/Content/!

Edit w Format w Insert w Per ization w 34 i ion w

ail/ContentEditor.aspx?borderSize=0&borderColor

| & Edit | {ntmi}

A Bl "™ R R SR
= Executive Vice Chancellor Lilly Marks Communique
Arial w| 10 ~ First Name
= Forever Buffs Insider
E|2F _A_ ¥ ||| Forever Buffs Online Community
Freestyle Skiing
Getches-Wilkinson Center
Giving Opportunities
GLBT Alumni News
Hispanic Alumni News
Hockey
Home City
Home State
Home Street 1
Home Street 2
Home Zip
Humanities Program
International Affairs
International Student and Scholar Services
Invitations from Chancellor Phil DiStefano
INVST Community Studies
Journalism and Mass Communication

Hi %%First Name%%

Laboratory for Atmospheric and Space Physics
Lacrosse
Last Name
Leeds School of Business
Legislative Updates
_ Mailing Address
Norlin Scholars
Office of International Education
(Vi of tha Vira Chancallor fnr Pacaarch

Quick Preview

Note the personalization list includes all of the email preference fields as well as the
Personalization fields. Below is a list of the current personalizations available.

A

Field Name

Personalization String

Example

Email Address

%%Email Address%%

MickeyMouse@disney.com

First Name %%First Name%% Mickey
Last Name %%Last Name% % Mouse
Advance ID %%Advance ID%% 1000000
Preferred Name %%Preferred Name%% Mickey
Prefix % Y% Prefix% % Mr

Home Street 1

%%Home Street 1%%

1234 Disney Way

Home Street 2 %%Home Street 2%% Apt A
Home City %%Home City% % Orlando
Home State %%Home State%% FL
Home Zip %%Home Zip%% 74174

Mailing Address

%%Mailing Address%%

1234 Disney Way Orlando, FL 74174 United
States
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%%Contact_ID%%

Contact_ID

0030000000YVXRT

Changing Content Area Type anding a Image

35. From the top of the wysiwyg editor
select ‘Orientation’ and then ‘Image

Bottom’.

36. Click the insert image icon.

37. Select the ‘Shared Portfolio Folder’
and the ‘CU branded buttons’

38. Select the button you would like to
use. Not there are several pages
of buttons.

39. Click ‘Ok’ to continue.

Edit » Format w Insert » Personalization
A [E:‘ [y LZJ [| v = Text Only
e e N B [4 image Only
e | 10 il B I J I; == - Image Top
S|E=] || A | | B8e | |[LNE [ Image Bottom
— i - “= |mage Left
Hi %First Name% =] Image Right
Free Form

| hope you are enjoying the training

Edit w Insert v

Orientation w

[ & Edit | {ntmiy

NEE A EenE

Arial 10 =

Hi %First Name%

| hope you are enjoying the training.

[Click here]
to insert
your image

36

Select Image:
Choose an image for your content area

Source: @ Folder O Other URL

[ [ Portfolio
=1 [ Shared Portfolio
|3 CU Branded buttons 37

[+ [ CU branded headers

Upload. .

Use image:

38

joinus_border_gold

() medium

) small

Image Size :

register_bevelled_black

Page20f3 | M| « MM

() large

register_bevelled_blue

(@) Original

39
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40. Select the ‘HTML’ tab to view and e i o | g e ‘EBT&
edit the content html. L)

iAHai F
&

Hi %First Name%

I hope you are enjoying the training

(Jonus )

41. To ensure the button renders correctly on mobile devices add the limportant tag to the
image. This is not required but should be added if the images are not rendering correctly
on mobile.

42. Click ‘Edit’ tab to go back to the wysiwyg editor.

Edit » Format w Insert w Personalization & EditJ.< html ) l

Q| 42

= |

<p id="text-placeholder"™ style="margin-top: Opx; margin-bottom: Opx;">

Hi %First Name$%

</p>

<p style="margin-top: Opx; margin-bottom: Opx;">

Exbopr

</p>

<p sty! margin—top: Opx; margin-bottom: Opx;">

I hope 41 are enjoying the training.<br />

</p>

<p align -"center" style="margin-top: Opx; margin-bottom: Opx;">

<img| !important| width="147" height="47" border="0" thid="ceef25b5-7a28-48ca-
afef-£dl4c6de3284" alt="joinus border gold" title="joinus border gold" style="margin:
Opx;"™ src="http://image.communications.cu.edu/lib/fe5213727561017c7c

image-placeholder™ />

/m/1/joinus border gold.jpg" id

University of Colorado | eComm
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Add a Second Image to the Section

43. From the top of the wysiwyg editor select
‘Orientation’ and then ‘Image Top'.

Repeat choosing Image Left and Image Right.

@ LEE ) E8uEaE- 0w

[t ~[« ~I[B|7Y][ElZZ=E

Z)ES) (A v)[me v

Notice how the editor automatically reformats the JOIN US

content.

44. Now select “Free Form’ from
the Orientation list.

45. Click ‘OK’ to continue.

46. The insert image icon is now
enabled. Click the icon to
add a second image.

Hi %First Name%

| hope you are enjoying the training

Edit w Format w Insert w Per lization w | Ori ion w ‘

( £ Edit | { html)

= Text Only

(4 Image only 43

v A Image Top

7] Image Bottom

= jmage Left

] Image Right

Free Form

Edit w Format w Insert w Personalization w Orientation w | ¢~ Edit ] ¢ html )
@) @S €3 -
— — e . 7 Image Only

S '” i = EimageTop

5 H EHE| |A v”ahc, v”L!N ™ Image Bottom

e ——— @\mageLeﬂ _—
Hi %First Name% v 2B |mage Right | JOIN US )
| hope you are enjoying the training. Free Form 44 :

You have chosen to switch to Free Form mode. Once you enter
Free Form, you cannot switch back to Smart Orientations. Click
OK to confirm that you want to change to Free Form.

|_O—K|45 Cancel

Edit » Format w Insert v Personalization w Orientation w

|._ ¥ Edit w ¢ htmly

CRROINEIEEWEE 2R

Y[ ¥I[B]7UEE=EE

Hi %First Name%

University of Colorado | eComm
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Select Image:
47 Select ‘Other URL’ Choose an image for your content area
source: OFolder @ Other URL
47
URL:
!www,t:u edu/sites/defal _Crop/685i) mhrathira\pme,pngl Validate URL
48. Enter URL of an image. For example: 48
http://www.cu.edu/sites/
default/files/media_crop/
685/public/ath_ralphie.png
49. Click ‘OK’ to continue.
Image Size : O small O medium O large @ Original
49
OK Cancel
50. Click ‘preview’ tab to preview the email.
51. Then click ‘Mobile’ icon to preview as mobile.
My Emails > Training - ASE > My First Email - ASE Add Campaign Association
p Properiies ./’ [:"lSend - :Send Preview £ Content Detective ] Validate iaf. Save as Template
Preview Mode: | [] 51 | P preview I< htmi p | [Z] text

50 ”

To view this email as a web page, go here.

Additional Email Steps

My Emails > Training - ASE > My First Email - ASE

™ Properties v,’ [ﬂ send :Senu Preview ) Content Detective W] Validate &) Save as Tempiate

Preview Mode: [ []

To view this email as a web page, go here.

\ Campus Programs

UNIVERSITY OF COLORADO BOULDER

Content Detective will validate your email for any Spam filter issues.

Validate will validate that any code or personalizations used in the email are correct.

Save as Template will save the email with the content as a template in the ‘My Templates’
folder.

University of Colorado | eComm
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From Email Folder

1. From the email folder select the
Email you would like to send by
clicking the check box.

2. Next click ‘Send’ and then ‘Guided
Send’

From Email
1. /2. If you are already in the email
simply click ‘Send’ and then
‘Guided Send’.

3. Click ‘Next’ to continue into the
Guided Send Wizard.

My Emails > Training - AE

i Create v WiCopy Tl Delete e+ Move | ™ Properties (Send v (D Pending Sends (& Past Sends

Name Subject [ Guided Send 2 Associated Campaign:
My First Email Marketing Cloud Trairf Simple Send
1 [ Test Send

My Emails > Training - AE > My First Email

s Properties @11 | |EBERAIRY [] seng Preview [ inbox Preview ¢ Content Detective [ Validate i Save as Template

) cudedsena ] 2
() Simple Send
[ Test Send

Show content borders

Alumni Affinity Groups
UNIVERSITY OF COLORADO BOULDER

Send Email

This wizard will walk you through sending an email to your subscribers.

The email that you selected is:

D: 41378
Name : My First Email

Subject :  Marketing Cloud Training

@ 2oy e

Preview:

L3 1
< Back Cancel

University of Colorado | eComm
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4. Select the Recipient Source of Send Emal
‘Salesforce reports or campaigns’. Cronss Recpnsoures
() Recipients: lists, groups or audi
. . (@ Salesforce reports or campaigns
® Do NOT select the first option. e
« Always select ‘Salesforce reports or
campaigns’.
5. Click ‘Next’ to continue.
5
< Back ‘Next >' Cancel
Send Email
Choose Salesforce Report or Campaign
Search to find the Salesforce Reports or Campaigns you want to send to
6. Click the first ‘Add’ button to add an inclusion You have the folloving Reports selectec:
report.
[Add [ @ Remove
- An Inclusion Report is the list of contact the Youlhave the folowing Compagns slected.
email will be sent to.
Add Remove |
. . . . . Send tracking data to Salesforce
Campaigns will be used for the inclusion list () Ao cpicte vl aeresses i sens
i [ 1 certify all of these people have opted in. [ View Certification Statement |
» when the send is related to Cvent Events and
Contact ID list | loads (eg: Advance IDs
Employee IDs ect).
Contact your MEC for help with ID upload list.
Look for Reports that meet this criteria
7. Enter the Name or part of the name of TR G
ame - contains hd ample
the report you Want to use. Note: To E:SU-T: ‘suc:essfulsend, a column in your report must contain 'Contact ID' or 'Lead ID' in a column name
or your send will fail.
Results: 8 Find Mow
You need to know the names of your 07 | Name = o
salesforce reports.
8. Click the ‘Find Now’ button.
< >
0K Cancel

University of Colorado | eComm
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Look for Reports that meet this criteria

9. Select the report you want to
use by checking the checkbox

MName : contains v | |5amp|e

MNote: To ensure a successful send, a column in your report must contain 'Contact ID' or 'Lead ID' in a

next to the report_ column name or your send will fail.
Results: Find Now
] | Name Type Owner ~
10 CIle ‘OK’ to Contlnue 9 2 Exclusion Report Report Anne Early
] Sainiple Report: # of Accounts Report Anne Early
OJ Sample Report: # of Cases Report Anne Early
] sample Report: # of Contacts Report Anne Early
w
(_ >
Page 1 of 2 (33 items) 12
10 DK o
11. Update Check boxes.
Send Email
a Send tracklng data to Choose Salesforce Report or Campaign
’ Search to find the Salesforce Reports or Campaigns you want to send to
Salesforce. Checked _
You have the following Reports selected:
by default’ UnCheCk é[l Sample Exclusion Report
the email does not
need to be tracked in [ Add Remove |
SaleSforce You have the following Campaigns selected:
b. Allow duplicate email
address in send. [ Add Remove |
UnCheCked by default, Send tracking data to Salesforce
H H 1 1 Allow duplicate email addresses in send
CheCk Only If there IS a | certify all of these people have opted in. [ View Certification Statement ]
need to send the
email to the same
email address more 12
< Back Next > Cancel

than once.

c. Check the ‘I certify all of these people have opted in.” This box must be checked
to continue.

12. Click the ‘Next’ button to continue.

University of Colorado | eComm
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13.

14.

15.

16.

17.

18.

Select the exclusion report for your
department.

An Exclusion Report is the list of
contacts the email should NOT be
sent to even if the contact is on the
inclusion list. these are the people
that have opted out of the emails.

Click ‘Next’ to continue

Enter the Name or part of the name
of the report you want to use.

Click the ‘Find Now’ button.

Select the report you want to use by
checking the checkbox next to the
report.

All unsubscribe reports have the
word 'UNSUB' in them.

Click ‘OK’ to continue.

Send Email

Exclude Salesf Repert or C.
Search to find the Salesforce Reports or Campaigns you want to exclude from sending to

You have the following Reports selected:

13

Add Remove

You have the following Campaigns selected:

Add || Remove

14

<Back | Next>! Cancel

Look for Reports that meet this criteria

V| ‘UB?UNSUB?Ad\rancement E\rentd 1 5:'

Note: To ensure a successful send, a column in your report must contain 'Contact ID' or 'Lead ID' in
a column name or your send will fail.

Name : contains

Results: Find Now

16

[] Mame Type Owner

No items to display

~
W

OK Cancel

Look for Reports that meet this criteria

MName : contains V| ‘DQ_UNSUB_Advaﬂcement Events

Note: To ensure a successful send, a column in your report must contain 'Contact ID' or 'Lead ID' in
a column name or your send will fail.

Results: Find Now
[] Name Type Owner
09_UNSUB_Advancement Events Report Anne Early

< >
Page 1 of 1 (4 items) 1 8 1
DK -

University of Colorado | eComm

16



19. You can update the Email S

SubJeCt Set Send Options

Set the from name, subject line and other options for this send

Subject : | welcome to Ecomm 1 9 Insert ¥ @

20. From Options/Send Classifications
a. Always select a Send Classification. Do Not select first Radio Button option.
b. Once you have selected a Send Classification verify that the delivery profile is
‘CU FOOTER FOR ALL EMAIL”

From Options

A I O Use the following fromm Tarme=mmd .ﬂcgl

@ Select a send classification
| CU Advancement Events

L] overwrite delivery profile with £ CU FOOTER FOR ALL EMAI

v|
] overwrite sender profile with : CU Advancement Events i
z::r\/ B

c. Do NOT select a send classification of ‘Default Commercial’ or ‘Default
Transactional’

— From Options

O use the following from name and address

@ Select a send classification
CU Advancement Events v

Advancement
CU Advancement Events
¢  |pefault Commercial llmportant!
— |} Default Transactional
[~ Sen Johnnie Ray Vice President A NEVER Select a send classification of
matt.roush@cu.edu

[ test advancement classificatio] ‘Default Commercial’ or ‘Default Transactional’
Test Email List Send Classific . |

— Send Option:

21. Select location of tracking information,

Send As Multipart MIME

by default it will be saved in the “My s e
Tracking” folder. If subfolders have g o

been created a subfolder can be 2|1 y Trackng ]
selected.  Testing Opton

D Send all emails to: ‘

Mete: An email for each subscriber in your list will be sent directly to the address you enter
Ahnve (i & selactinn a list with 50 sihscribers will sand il 50 amails to z’m_bm’.adﬂmsl_.zz il

v

<Back | Next>! Cancel

22. Click ‘Next’ to continue.

University of Colorado | eComm
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Send Email

23. Select Send Time.

Schedule Send
Select the date and time to send the email

@ Immediately 23
The email will be sent upon completion of this wizard.
H ‘ ’ H () Later
24 C I | Ck N eXt tO Contl nue The email will be sent at the date and time specified below:

Thursday , January 21, 2016 BB | 600Am

Send

24

<Back | [Next>| | cancel
25. Confirm information Send Send Email
information is correct and check Confirm Send
Reviews your selections before sending the email
¢ . f . . y
the “This information is correct
You have supplied the following infermation for this email send:
checkbox. - =
Email Preview
Name : My First Email P
Subject : Marketing Cloud Training z
Preheader:
. ‘ , From : University of Colorado
26 CI|Ck the Send button to Send <email@communications.cu.edu>
the ema” De-duplicate Subscribers True
Multipart MIME : Yes
Link Tracking : True
Suppress from Reports False
Tracking Folder: Test Send Emails
Recipients
Salesforce Report: Training Sample Include o

This is not a test email and will be sent immediately.
This information is correct

25
26

< Back Send Cancel

Send Email

Email Sent!

27 . E mall Sent! CI|Ck ‘Fin ished’ Your email has been successfully sent. You can view the send progress under Interactions

-> Salesforce Sends.

Name: GuidedSend_32b4c125-3cea-4f3a-b068-e05712d0b1do
* ExternalKey: 4674

Click Finish below.

27
< Back | iFinish Cancel
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1. To view email tracking
information select the
‘Tracking Tab’ then
‘Sends’

Click into the ‘My
Tracking’ folder on the
left.

Click on the Email
Name hyperlink to view
the tracking information

4. The ‘Overview’ tab provides open rate

information.

5. The ‘Click Activity’ tab provides click
rates for each link included in the

email.

My Tracking
~ -
[ERm] My Tracking 2 - L]
| Salesforce Mass Sends [] JobID
|1 Salesforce Single Sends [ 266055
[ Test Send Emails
|3 Triggered Sends LI 1033832
| Journey Builder Sends [1 1045454
|1 A/B Testing [ 1045460
Wy Reports [J 1048181
. Repurt. Status and History [ 1048193
+ Administrator Reports
+ Email Send Report D 1048244
+ Email Sends by User b [ 1050003
+ Subscriber Reports I O 1050088
+ Email Reports
+ Email Performance By Attril [ [Rio50287
+ Email Performance by Do [] 1050296
+ Email Performance by List O 1053150
+ Email Performance for All G .
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Marketing Cloud Help

To find Marketing Cloud help, click the arrow next to your name at the top right of the screen
and select ‘Marketing Cloud Help’
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